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1. Attekintés

A gyakorlat célja: Megismertetni a hallgatdkat az adattarhazak felépitésének alapjaival.

A gyakorlat tartalma: A gyakorlat sordan a hallgatok kiilonboz6 adatkinyerési és
transzformacios 1épések utjan adattarhazat hoznak Iétre, amit web-alkalmazasként is
kozzétesznek. A gyakorlat a kovetkezd fobb elemekbdl fog allni:

* Adattarhaz projektek 1étrehozéasa az IBM DB2 Data Warehouse Edition Design Studio
9.1.2-es verzidjaval.

* Data Flow adatfolyamok Iétrehozasa, és szerkesztése

* Szoveges adatfajlok tartalmanak adatbazis tablakba mozgatasa adatfolyammal

* Adatmindség javitasa tovabbi adatforrasok hozzaadasaval (az staging adatbazis tablak
tartalmanak automatikus ellendrzése referenciak altal)

* Adatfolyamok végrehajtasa

* Végrehajtasi Terv Grafok (EPG-k) generalésa, és értelmezése

* Vezérlési folyamok (Control Flows) 1étrehozasa, és adatfolyamok integracioja

» [teracid beépitése a vezérlési folyamokba

* Vezérlési folyamok adatfolyam-alkalmazasokba csomagolasa

»  Websphere Application Server (WAS) alkalmazas-szerver lizembe helyezése

*  WAS web-alkalmazasaihoz tartozo6 adatforrasok megadasa

* Adatfolyam-alkalmazas kozzététele WAS web-alkalmazasként, és a kozzétett web-
alkalmazas folyamatként valo futtatdsa, monitorozésa, és hibakeresése

e WAS web-alkalmazasok eltavolitasa, és az alkalmazas-szerver leallitasa

* Adatbazis CubeViews szamara torténd elokészitése (adatbazis engedélyezes)



2. Kritériumok

A gyakorlat soran a hallgatoknak 3,5 dranyi tiszta munkaid6 all a rendelkezésére. Ezalatt az
id6 alatt kell teljesiteniiik a kovetkezd szakaszban felsorolt feladatokat. A gyakorlat soran
végzett munka a gyakorlat végén keriil megitélésre (teljesitmény, €s mindség tekintetében).



3. Feladatok

1.

Inditsuk el a ,C:\ VMMar e- i mages\ okt at as\ VI M A430_-
_Intelligens_Rendszerek_2_| abor _-_DWB50ERC4_-_3rd_exerci se” konyvtarban
talalhato ,,3rd exerci se. vnx” virtualis gép ,,Mer esEl ot t " nevil snapshot-jat (dupla
kattintas a VMX fajlra, VM - Snapshot > MeresElott 2> Yes, Start this virtual
machine, View = Full Screen).

A virtudlis gépen 1épjiink be a Windows-ba ,,db2adni n” felhasznaldként, .,.i bn2bl ue”
jelszdval (és varjuk meg, amig minden rendesen betoltodik).

A kovetkezokben az SQL Warehousing Tool (SQW) nevezetli eszkozzel fogunk
megismerkedni, amely az IBM DB2 adatbazis-technoldgiajara épiilé adattarhazak belsd

crer

egységes, lzleti folyamatainkhoz illeszkedd adattarhazba integralhatjuk a kiilonb6zo,
heterogén adatforrasokbol (relacids adatbazisokbdl, tajlokbol, stb) szarmazo adatokat.

3.

Inditsuk el a ,,Design Studio”-t az asztalon, €s miutan elindult, csatlakozzunk a
DWESAMP adatbazis szerverhez (rdviden: adatbazishoz). A Database Explorer
részen (bal oldalt lent) kattintsunk a jobb egérgombbal a DWESAMP kapcsolatra, és
valasszuk a Reconnect opciot. Csatlakozzunk ,,db2adni n” néven és ,,i bn2bl ue”
jelszdval.

A kovetkezokben hozzunk 1étre egy Uj adattarhaz projektet (File > New —> Data
Warehouse Project).

A projekt neve legyen: DW350 Warehouse Project. Kattintsunk a Next gombra. Az
adattarhaz projekt most hozza szeretne férni a forras és cél adatbazis tablakhoz, igy hat
ezeket meg kell adnunk a Data Project részben. Egy, vagy tobb Data Project-et is
kapcsolhatunk egy-egy Warehouse Project-hez. Most a DW350 Data Project nevii
Data Project-et valasszuk ki, és kattintsunk a Finish gombra.

Lathatd, hogy a Data Project Explorer részen (bal oldalt fent) megjelent az imént
l1étrehozott adattarhaz projektiink. Bontsuk is ki, majd bontsuk ki benne a Databases
részt, és azon beliil kattintsunk duplan a DW350 Data Model.dbm adatmodellre.
Ennek hatasadra megnyilik az adatmodell (és egyben a vasznon is megjelenik — ne
zérjuk le). Lathato, hogy a modell a DWESAMP adatbazisra hivatkozik, 4&m azon
beliil csak a DWH és MARTS sémara.

Bontsuk ki tehat a Database Explorer részben (bal oldalt lent) a megfeleld, immar
zolden vilagité adatbazis kapcsolat sémait (DWESAMP -> DWESAMP -
Schemas). Itt latszik, hogy a DWH és MARTS nevezetli adatbazis sémak mellett még
szamos egyéb séma is megjelenik. Egyszersitsiik le a dolgokat. Kattintsunk jobb
egérgombbal a Schemas feliratra, és valasszuk a Filter opcidt, majd kattintsuk ki a
Disable filter jelolddobozt, valasszuk ki a Selection radidgombot, és jeloljik ki a
DWH és MARTS sémakat, majd kattintsunk a Finish gombra. Ezek utan, ha gjra
kibontjuk a Schemas részt, mar csak az el6bbi két sémat fogjuk latni benne.



A kovetkezOkben ratériink az adattarhaz projektiink létrehozdsanak lényegi okdra: olyan
adatfolyamokat (Data Flows) fogunk épiteni, melyek kiilonb6z6 DB2-es adattablak kozott
fogjak mozgatni, és transzformalni az adatokat.

8.

10.

11

12.

A Data Project Explorer részben (bal oldalt fent) a DW350 Warehouse Project nevii
adattarhaz projektiinkon beliil kattintsunk jobb egérgombbal a Data Flows-ra, majd
New - Data Flow. A létrehozni kivant adatfolyam neve legyen ,,Load DWH Fact”,
majd Finish. Lathatd, hogy jobb oldalt megjelenik a felhasznalhato adatfolyam-

rrrrr

feleldsek.

A kovetkezokben adjuk meg az SQW-nek, hogy mely DB2-es adatbazist hasznalja a
végrehajtas soran. Alul, a Properties részben kattinstunk az SQL execution schema
ikonra. Itt vagy konkrét sémat adunk meg, vagy egy valtozonak a nevét. Az utdbbi
megoldas az adattarhdz alkalmazas kozzétételekor (deployment) nagyobb
rugalmassagot biztosithat, &mde mi egyeldre maradjunk a fix értéknél. Legyen ez a
DWH séma.

Hasonldképp adjuk meg az SQL execution database-t is. A legordiildé meniibdl
valasszuk ki a DWESAMP adatbazist.

. A kovetkezdkben két szovegfajl adattartalmat fogjuk ,,befolyatni” az adattarhazunkba.

A jobb oldalt lIathat6é adatfolyam-operator palettdbdl ragadjuk ki a File Import névre
keresztelt operator tipust, ¢s — folyamatosan nyomva tartva az egér bal gombjat —
mozgassuk a ,,L.oad DWH Fact” névre keresztelt adatfolyamunkhoz tartoz6 vaszon
(k6zépen) bal oldalara. Az adatfolyamok mindig balrél jobbra haladjanak!

A feljovo ablakban bongéssziik ki a megfeleld fajlnevet
(C:\DW35\SQW\DWH _ITM_TXN_1.txt), majd kattintsunk az Open-re. Ezek utdn
kattintsunk a Next-re, hogy beallithassuk az imént megadott fajl formatumat
(szintaxisat). Ehhez kattintsunk a Load from File Format gombra, ¢s valasszuk ki a
megfeleld formatum-leiro f3jlt (C:\DW35\SQW\dwh_itm_txn.fileformat), majd
Open, Next, és Finish.

Lathatd, hogy a formatum-leir6 fajl egy meta-adat, amelyet valaki manuélisan hozott létre

ahhoz,

hogy az altala leirt adatforrasokbol automatikusan kinyerhet6vé valjanak a sziikséges

adatok. Esetiinkben tehat adott felépitésli DB2-es adatbazis tablaba fognak keriilni az
importalt fajlokban 1évé adatok.

13.

14.

Az elobbiekhez hasonldan egészitsiik ki adatfolyamunkat egy ujabb File Import
operatorral, amely a C:\DW3S\SQW\DWH_ITM_TXN_2.txt f4jlt olvassa be. Itt
azonban, miutan az operatort a palettarol a vaszonra mozgattuk (az elébbi File Import
operator ald), nyomban zarjuk is le piros X gombbal a felugré dialogus ablakot, és a
l1étrehozott/kivalasztott operator Properties részében (lent) adjuk meg a megfeleld
informéciokat, azaz itt bongéssziik ki az importalandé f4jl nevét, illetve a formatum-
leird fajlt is.

A kovetkezokben mindkét File Import operator mellé tegyiink egy-egy Distinct
operatort, és kossiik 6ssze a megfeleld File Import operatorok kimenetét (output port-
jat) a megfeleld Distinct operatorok bemenetével (input port-javal).



15.

Mindkét Distinct operator Properties részében (lent), azon beliil a Column Select
rész Selected Columns mezdjében valasszuk ki (a CTRL gombot lenyomva tartva, bal
egérgombbal kattintva) az MKT_BSKT _TXN_ID, PD_ID, és ITM_TXN_TMS
oszlopokat, majd kattintsunk a Kis sarga balra nyilra.

Ennek hatdsara a Distinct operatorok result kimenetén a megfeleld, beimportalt fajlok adott 3
mezodben egyitittesen kiillonb6z6 adatai fognak ismétlodés nélkiil megjelenni, mig a discard
kimeneten azok az adatok jelennek meg, melyek eredetileg tobbszor is eléfordultak (az adott
3 mez0 egylittes értékét tekintve).

16.

17.

A duplikélt adatokat irjuk ki egy-egy kiilon fajlba! Ehhez el6szor is mozgassunk egy
File Export operatort a vaszonra, a fentebbi Distinct operatortdl jobbra, és picit
lentebb, majd X-eljiik ki a felugré ablakot.

Az elhelyezett File Export operator Properties részében, azon beliil a General fiilben
kattintsunk a File Name mellett 1évé gombra (amin a kis gyémant, és Al-es felirat
szerepel), majd valasszuk ki a Use Variable opciot.

Itt tehat egy fokkal rugalmasabbak szeretnénk lenni, €s valtozoként szeretnénk definidlni
annak a fajlnak a nevét, amelybe a duplikatumok keriilnek.

18.

19.

20.

21.

22.

23.

24.

Kattintsunk tehat most a File Name melletti beviteli mez6 jobb oldalan a .,...”" gombra,
aminek hatdséra feljon egy Variable Selection ablak.

Hozzunk létre egy valtozo-csoportot! A Variable Groups mezd alatt kattintsunk a
New gombra, és DW350 néven hozzuk létre a csoportot.

Az imént létrehozott valtozo-csoporton beliill definialjunk most két valtozot (egymas
utan, egyenként)! A Variables listatdl jobbra fent kattintsunk a New gombra, €s adjuk
meg a valtozo nevét, értékének tipusat, értékét, és azt, hogy legkés6bb mikor lehet
ezen az értéken valtoztatni (tervezési idében, futdsi idében, stb). Az egyik valtozo
neve discard1, a masiké pedig discard2 legyen. Mindkett6 tipusa File. Ertékiik rendre
c:\temp\discardl.txt, és c:\temp\discard2.txt. A Final phase for value changes
mez0 érteke pedig EXECUTION_INSTANCE legyen.

Miutan 1étrejott mindkét valtozo, és lathatoak a Variables listdban, kattintsunk a
discardl-re, és nyomjuk meg a Replace gombot. Ennek hatdsdra File Export
operatorunk a discard]1 valtozoval azonositott fajlt fogja ezek utan generalni.

Hozzunk 1étre egy masik File Export operatort is (az alsé Distinct operatortol jobbra,
picit lentebb), az el6z6hdz hasonloképp, dmde az export-alt fajlra immar a discard2
valtozo hivatkozzon.

Most pedig kossiik Ossze a megfeleld Distinct operatorok discard kimenetét a
megfeleld File Export operatorok input bemenetével.

Ezek utan kombindljuk 6ssze a két Distinct operator kimenetét! Hizzunk egy Union
operatort a vaszonra, ¢s kossiik az input bemeneteire a File Export operatorok result
bemeneteit, majd bizonyosodjunk meg arr6l, hogy Union operatorunk Properties-
ének Set Details fiilében a set operation beallitas UNION-ra van allitva.



25.

26.

27.

28.

29.

30.

31.

32.

33.

34.

35.

Ahhoz, hogy adatfolyamunk eddig (vagy barmely Iépésben) eldallitott kimenetét
vizsgalni tudjuk (pl. ellendrizni), egy Data Stage-et kell 1étrehoznunk a folyamon
beliil, a megfeleld helyen. Mozgassunk most tehat egy Data Station operatort a
vaszonra (a Union-tol jobbra), és kossik az input bementére a Union result
kimenetét, és a Ctrl+S billentylikombinacié lenyomasaval mentsiik eddigi munkankat.

A Data Station operator azonban egyeldre még milkodésképtelen, mivel egy valddi
adatbazis tablara (egy ugynevezett Staging Table-re) van sziiksége ahhoz, hogy az
adott 1épésben eldallt adatokat el tudja helyezni. A Data Project Explorer-ben (balra
fent) bontsuk ki a kovetkezoket: DW350 Warehouse Project > Databases >
DW350 Data Model.dbm > DWESAMP - DWH

Mivel esetiinkben a Staging Table az ITM_TXN téblaval megegyezd lesz, ezért
masoljuk le ezt a tablat. A Data Project Explorer-ben kattintsunk ra jobb gombbal,
majd Copy, és kattintsunk jobb gombbal a DWH sémara, majd Paste.

A létrejott, Copy of ITM_TXN nevii tabla Properties részében irjuk at a tabla nevét
ITM_TXN _STAGE-re (és pl. a Label mezdre atkattintva érvényesitsik a
valtoztatasokat).

Uj tablank egyelére ,,csak” egy modell, nincs még fizikai manifesztaciéja. Kattintsunk
tehat jobb egérgombbal az ITM_TXN_STAGE tablara a Data Project Explorer-ben,
¢és valasszuk a Generate DDL opciot. Kattintsunk most a Deselect All gombra, és
miutan minden jel6lédoboz inaktivva lett, kattintsuk be a Fully qualified names, és
CREATE statements jelolddobozokat, majd Next, aztdn megint Deselect All,
jeloljiik ki a Tables-t, és megint Next.

A generator SQL script neve (File Name) legyen ITM_TXN_STAGE.sql. Kattintsuk
be tovabba a Run DDL on server opciot, ¢s Next.

Ezen a képernydn valasszuk a Use an existing connection opcidt, ¢s a DWESAMP
kapcsolatot, majd Next, és Finish. Ennek hatasara tehat bizonyos kényszerek, és
egyeb sajatossadgok nélkiil, sikerrel 1étrejott az ITM_TXN fizikai adattdbla mésolata,
az I'TM_TXN STAGE (ami immar a Database Explorer-ben is lathatdé kell, hogy

legyen).
Mentsiik le minden eddigi munkankat: File > Save All

Most pedig, miutdn végre létrejott egy valddi Staging Table, kattintsunk az
adatfolyamunk vasznan a Data Station operatorra, és vegyiik szemiigyre a Properties
részt (lent). El6szor is a Station type PERSISTANT _TABLE kell, hogy legyen.

A Staged database table beviteli mez6t6l jobbra taldlhato ,....” gombra kattintva
bongéssziik ki a DWH.ITM_TXN_STAGE tablat. Ezzel tehat megadtuk, hogy a Data
Station adatfolyam-operator kimenete konkrétan hova kertiljon.

Kattintsunk az adatfolyamunk vdasznara, és nyomjunk egy Ctrl+S billentyli
kombindaciot (ezzel lementve az imént tovabb mddositott adatfolyamunkat).



A kovetkezdkben validalni fogjuk a Staging Table-ben 1évé adatokat. Ehhez referencia
gyanant két tovabbi adatforrast iktatunk a folyamba.

36.

37.

38.

39.

40.

41.

Lehet,

A vaszon jobb oldalan lathato palettar6l mozgassunk egy Table Source operator
példanyt a Data Station ald az adatfolyamban.

Mivel a forras tabla a DWESAMP adatbazisban van, tovabba az Execution Database
(az adattarhaz tekintetében) ugyancsak a DWESAMP adatbazis, ezért a Table Source
operatort Properties részében a Location opci6 maradhat most SQL execution
database.

Bongéssziik most ki azt a forras tablat (amit referencia gyanant fogunk hasznalni
ahhoz, hogy ellendrizzikk a Data Station kimenetén keletkezd adatok helyességét)!
Kattintsunk a Source database table beviteli mez6tol jobbra 1év6 ,,...” gombra, és
bongéssziik ki a DWH.PD adattablat.

Ezek utan illessziik be a folyamba a masik referencia forras-tablat! Az elébbiekhez
hasonloan helyezziink el egy Table Source operatort az el6bbi ala, és forrastabla
gyanant bongéssziikk ki a DWH.MKT_BSKT_ TXN tablat. Finish.

Ezen utdn helyezziink el egy Key Lookup operdtort a vdsznon a Data Station, és
Table Source operatoroktol jobbra, majd kattintsunk a lookup port-ja alatti kis ikonra
ahhoz, hogy még egy lookup port j6jjon 1étre rajta (lookupl). Kossiik a Data Station
result kimenetét a Key Lookup data bemenetére. A PD Table Source output-jat
kossiik a Key Lookup lookup-jara, mig az MKT BSKT TXN Table Source output-
jat a lookup1-re.

A kovetkezokben konfiguraljuk kicsit a Key Lookup operatort! A Properties részben
valasszuk ki a Condition List fiilet. A lookup port-nak megfelelé sorban kattintsunk
bele a Value mezdbe, és utana a megjelend .,....” gombra, majd alkossuk meg a
kovetkezd SQL allitast: DATA _018.PD_ID = LOOKUP_018.PD_ID

hogy 018 helyett mas szam fog szerepelni (ha példaul elézdleg tordltiink valamiféle

operatort, majd Gjra 1étrehoztuk azt), de ez a 1ényegen nem valtoztat...

42.

43

44,

Ha kész az SQL kifejezés, OK, majd hozzuk Iétre hasonloképp a lookupl port-hoz is a
kovetkezo kifejezést: DATA 018.MKT_BSKT TXN_ID =
LOOKUP1_018.MKT_BSKT_TXN_ID

. Most kattintsunk a Key Lookup operator Properties-ének Select List fiilére, és ott

kattintsunk a Results Columns téblazat elsd sordba, majd a Shift gomb lenyomasa
mellett az utolsé soraba is. Ennek hatasara kijelolddik a teljes tablazat. Ekkor
kattintsunk a piros X gombocskéra a tablazat fejléce felett (ahhoz, hogy tordljik a
tablazat tartalmat). Megjegyzes: ezt egyébként a tablazat tetején elhelyezkedd
dupla/sziirke X gomb lenyomasaval is megtehettiik volna mindenféle kijel6lés nélkiil.

Ezek utdn az Available Columns részben jeloljiik ki a DATA_018-hoz tartoz6 6sszes
oszlopot, és kattintsunk a sarga jobbra myilra (ahhoz, hogy atmozgassuk dket a
Result Columns-ba).



45. Most pedig, miutan megoldottuk a Key Lookup operdtor altal végzett
Osszehasonlitast/validalast, probaljunk meg azokkal az adatbazis bejegyzésekkel (azaz
sorokkal) is kezdeni valamit, amik nem mentek at a szlir6n, avagy nem egyeztek a
referencia-adatokkal. Ehhez el6szor is mozgassunk egy File Export operatort a Key
Lookup operatortdl jobbra. A felugrd képernyén a kovetkezd fajlnevet adjuk meg:
c:\temp\discards_item_txn.txt, majd Finish, és kossiik a Key Lookup discard port-
jat az 0j File Export operator input port-jahoz.

46. Mit kezdjiink viszont azokkal az adatokkal, amik atmentek a sz{iron (match)? — Hat
probaljuk meg 6ket egy adatbazis tablaba tolteni. Ehhez helyezziink el egy Bulk Load
Target operatort a Key Lookup operatortdl jobbra, a File Export f6lé. A Load into
database table mez6tél jobbra 1évé ....” gombra Kkattintva bongéssziikk ki a
DWH.ITM_TXN tablat, majd allitsuk a Load mode-ot REPLACE-re, és Finish.

47. Ha ez kész, kossiik a Key Lookup match port-jat a Bulk Load Target operator input
port-jara. A felugro listabol valasszuk a Connect by name opciot (mivel a Key
Lookup match kimenetén el6alld virtudlis tabla strukturdja gyakorlatilag megegyezik
Bulk Load Target-ben megadott DWH.ITM_TXN tablaéval).

48. Ellendrizziik, hogy megfelel6-e a mezdk Osszeillesztése! Ehhez kattintsunk a Key
Lookup, majd pedig Bulk Load Table operatorok jobb felsd sarkaban taldlhatd + jelre.
Ha minden stimmel, akkor a — jellel Ujra elrejthetjiik a részleteket.

49. Mentsiik le eddigi munkankat: kattintsunk az adatfolyam vasznara, és Ctrl+S.

50. Elkésziilt tehat az adatfolyam. Ellenérizziik, hogy jo-e: a fenti meniibdl valasszuk ki a
Data Flow = Validate opciot, aztan OK.

51. Ha az imént stimmelt az adatfolyam, ugy hajtsuk most végre! Kattintsunk a Data
Flow = Execute meniipontra. A felugro képernyén gyakorlatilag minden (Diagnostic,
Resources, és Variables) megfelel6 most. De azért kattintsunk csak rd a Variables
flilre, és nézziikk meg, hogy az adatfolyamunkban jelenleg szerepld 2 valtozonak
aktudlisan éppen most mi az értéke.

52. Miutan mindent szemrevételeztiink, €és megfelelonek talaltunk, kattintsunk az Execute
gombra. Ha minden rendben lefutott (Execution succeeded), akkor OK. (Megjegyzés:
el6 szokott fordulni, hogy annak ellenére, hogy mindent jol csindltunk, a végrehajtds sordn
néviitkozésre hivatkozva hibdt jelez a rendszer (bug). Ekkor toréljiik a megfelelé Distinct
operdtort a folyambol, és ugyanugy hozzuk létre még egyszer. Ezt addig ismételjiik, amig
végiil mar gond nélkiil lefut a folyam. Az operdtor result port-janak Union-os input-ra
kotésekor a felugré meniibl a Connect by name opciot vdlasszuk.) Az eredményt pedig
ugy mintavételezhetjiik, ha a Database Explorer-ben az ITM_TXN_STAGE ¢és
ITM_TXN tablakra jobb egérgombbal kattintva kivalasztjuk a Data - Sample
Contents opciot (aminek hatasara az also ablakban lathatova valik a Data Output).

Felmeriilhet a kérdés, hogy valdjaban, fizikai szinten hogyan is zajlik egy ilyen adatfolyam
végrehajtasa. A vélasz az EPG (Execution Plan Graph) végrehajtasi-terv grafokban rejlik. Az
EPG grafok az adatfolyamhoz képest olyanok, mint a bytecode (.class) a Java forraskodhoz
képest: a JVM (Java Virtual Machine), avagy most igazabol az SQW keretrendszer ezeket
képes végrehajtani, az adatfolyamokat 6nmagukban nem, csak forditas utan. Ez tobbek kozt
nagyfoku platform fiiggetlenséget jelent.
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Ahhoz, hogy megtekintsiik az adatfolyamunkhoz tartoz6é EPG gréfot, generalnunk kell
a kodjat: legyen kivalasztva az adatfolyamunk (pl. Gigy, hogy a véaszonra kattintunk),
majd a mentibdl valasszuk ki a Data Flow > Generate Code opciot. Rovid
attekintést kovetden le is zarhatjuk a kigeneralt scipt-et...

A kigeneralt script-nél ugyanis van az EPG grafoknak egy joval szemléletesebb,
adatfolyamokéhoz hasonld megjelenitése is. Ahhoz, hogy ezt megnézhessiik, legyen
kivalasztva az adatfolyamunk (Load DWH Fact), és a meniib6l valasszuk a kovetkezo
opciét: Data Flow = View Generated EPG - Runtime EPG

A megjelenitett graf gyakorlatilag méar egy Control Flow vezérlési folyam (rovidesen
errdl is szdt ejtiink bovebben). Ahhoz, hogy ebben a viszonylag komplex folyamban
hibat tudjunk keresni, tegyiik a kovetkezot: gyézddjiink meg arr6l, hogy a Runtime
EPG van aktualis kivalasztva (pl. a vasznon a megfeleld fiil kék), ¢és kattintsunk a
mentisor (amiben a File, Edit, Navigate, ... meniik vannak) alatt elhelyezked6 ikonok
koziil a kis zoldes bogarkara (amely a méretezéstol kozvetleniil jobbra van). Ha a
megfeleld ikon f6lé vissziik az egérkurzort, akkor a kovetkezd felirat kell, hogy
megjelenjen: Debug the execution plan graph (EPG). Kattintsunk tehat erre az
ikonra.

A hibakeresés azonnali megkezdéséhez kattintsunk a Debug gombra, majd kattintsunk
a kis z6ld bogarka ikontdl balra megjelent sarga lefelé nyilra. Ha folé vissziik az
egérkurzort, a kovetkezd felirat jelenik meg: Execute the current node and move to
the next — ebbdl is latszik, hogy e gomb egymas utan torténd lenyomasaval
1épésenként haladhatunk végig az EPG-n. 8-9 lenyomas utdn példaul a Console-on
meg kell, hogy jelenjen egy SQL-es tizenet, mivel végrehajtasra keriilt egy
SQLCodeUnit. Tovabb nyomkodva a nyilacskat ujabb SQLCodeUnit-ok végére
érhetiink (amit jabb Console tizenetek jeleznek).

A hibakeresés befejezéséhez kattintsunk a sarga lefelé nyil melletti Kis piros kockara.
A kocka funkcidja a kovetkezd: Cancel debug session.

Ezek utan zarjuk le az EPG grafot, és a ,,L.oad DWH Fact” adatfolyamot is (a vdsznon
1€v6 fiilek kis X gombjaival).

Az imént létrehozott adatfolyam nagyszerien mikodott, azonban Onmagaban nem
alkalmazhat6 futdsi (runtime) kornyezetben. Azaz példaul nem tehetjiik 6nmagaban kozzé
(deploy), mint egy WAS (Websphere Application Server) alkalmazas szerveren futé web-
alkalmazast. Ehhez eldszor is egy Control Flow vezérlési folyamba kell dgyazni (egy, vagy
tobb) adatfolyamunkat, és utdana a vezérlési folyamot, mint folyamatot (process) futtatni a
WAS szerveren, persze csakis miutan kozzétettiik. A kovetkezOkben tehat ebbe az irdnyba
fogunk elindulni. Ennek soran meg fogjuk érteni, hogy mi a kiilonbség a vezérlési folyamok,
¢s az adatfolyamok kozott, €s miért van sziikség az utobbiak eldbbiekbe valo beagyazasara.
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Hozzunk 1étre egy uj adattdrhdz projektet, amely egy részleges projektre épiil!
Kattintsunk a File > New > Other opciora. Ezen beliil Data Warehousing >
Samples > SQL Warehousing Sample — Partial, és kattintsunk a Next-re.

A projekt neve legyen DW350 Partial Project. Kattintsunk a Finish-re.
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Zarjuk le a megjelent README-t, illetve minden mast is a véasznon, tovabba
zsugoritsuk Ossze a Data Project Explorer-ben is az esetleg kibontott Warehouse
Project-iinket (az attekinthet6ség kedvéért).

A Data Project Explorer-ben jobb egérgombbal kattintsunk a DW350 Partial Project-
re, és valasszuk a Project References opciot. Valasszuk ki a DW350 Data Project-ct,
¢s OK.

A Data Project Explorer-ben bontsuk ki a DW350 Partial Project > Data Flows
részt. Lathatd, hogy ehhez a projekthez tobb adatfolyam is tartozik. Ezek koziil
nyissuk is meg a marts-store nevezetii adatfolyamot dupla-kattintassal.

A véasznon egy lres részre kattintva ellendrizziik, hogy a Properties-ben (lent) az SQL
execution schema értéke MARTS, ¢és az SQL execution database értéke DWESAMP.

Az utolsé Table Join operatorral valami nem stimmel. Ezt jelzi a bal fels6 sarkaban
lathatd piros X is. Kattintsunk ra erre. Ahhoz, hogy orvosoljuk a problémat, OK,
aztan az operator Properties részének Condition fiilében a .,...” gombra kattintva
egészitsik ki az SQL kifejezést a kovetkezd sorral: AND IN_023.0U_TP_ID =
IN1_023.CL_ID. Ennek hatadsara nagyjabol a kovetkezd SQL kifejezésnek kell
adddnia:

I N3_023. "parentkey" = I N2_023. "nmenber key" AND
I NA_023. "parent key" = I N3_023. "nmenber key" AND
I N5_023. "parentkey" = I N4_023. "nmenber key" AND
IN_023. QU_I P_ID = I N5_023. "nenber key" AND
IN_023. QU_IP_ID = IN6_023. QU_| P_I D AND

IN.023. QU TP_ID = IN1_023.CL_ID

Ha ez kész, kattintsunk az OK gombra az SQL Condition Builder-ben.

Most mozgassunk egy Order By operatort a vdszonra a Table Join-t6] jobbra. Mivel
inner join miveletet szeretnénk, ezért a Table Join inner port-jat csatlakoztassuk az
Order By input-jara.

Az Order By operator Properties részében, a Sort Key Ordering fiilben a Sort
Columns-hoz adjuk hozz4 az STR_IP_ID oszlopot.

Tegylink egy Table Target operatort az Order By operatortdl jobbra.

A Target database table értékét bongészés utjan allitsuk MARTS.STORE-ra, az
SQL operation-t hagyjuk Insert-en. Kattintsunk a Finish-re.

Csatlakoztassuk az Order By operator result port-jat a Table Target input-jahoz.

Kattintsunk az egér jobb gombjaval az imént létrehozott kapcsolatra (a két operator
port-jai kozott), és valasszuk az Edit = Edit Column Connections opcidt.
Ellendrizziik, hogy a kimeneten €s a bemeneten rendre ugyanazok az oszlopok
szerepelnek-e (azaz megfeleld-e a mapping/leképezés).



73. Az OK-ra kattintva zarjuk le a Connections ablakot, mentsiik le eddigi munkénkat (pl.
Ctrl+S), és validaljuk a kiegészitett adatfolyamot: Data Flow - Validate

Lathatd, hogy az eldbbi beavatkozasok hatasara eltint a Table Join operatornal hibat jelzot
piros X jel. Adatfolyamunk tehat immar megfeleld.

74. A Data Project Explorer-ben most nyissuk meg a marts-fact adatfolyamot (dupla-
kattintas), és keressiik meg benne az egyetlen Group By operatort, majd menjiink a
Properties részének a Select List flilébe. A Result Columns listdban az Expression
nevezetli oszlopot szélesitsiik ki ugy, hogy minden, ami benne szerepel, lathatéva
véljon.

75. Kattintsunk bele az Expression oszlop azon mezejébe, amelyben a kovetkezd szerepel:
INPUT _014.SUM_ITM_STM_PRC * INPUT _014.SUM_NBR ITM

76. Kattintsunk ezek wutdn a mezében megjelend ,...” gombra (ahhoz, hogy
szerkeszthessiik az SQL kifejezést).

77. A Functions részben bontsuk ki az AGGREGATION-t, és kattintsunk duplén a
SUM(DOUBLE)-ra. Az SQL text részben korrigdljuk az SQL kifejezést
(pontosabban  a  zardjeleket) ugy, hogy a  kovetkezd  adodjon:
SUM(INPUT_014.SUM_ITM_STM_PRC * INPUT _014.SUM_NBR _ITM)

78. Ha kész, OK. Ugyanigy alakitsuk at az INPUT_014.CG_PD_DEPT_NM kifejezést a
kovetkezoére: MIN(INPUT _014.CG_PD_DEPT_NM)

79. Ha ezzel elkésziiltiink, kattintsunk a moédositott marts-fact adatfolyam vésznara, €s
mentsiik a valtoztatasokat (Ctrl+S), majd validaljuk az adatfolyamot.

A kovetkezokben Control Flows vezérlési folyamokba fogjuk dgyazni a Data Flows
adatfolyamokat. Lényegében tehat az adatfolyamok a vezérlési folyamok egyes
Llépései/operatorai” lesznek. A kiilonbség abban lesz, hogy a vezérlési folyamban nem adatok
folydogalnak, hanem konkrétan a vezérlés (mint pl. egy IF-THEN-ELSE struktiraban).

80. A Data Project Explorer-ben, a DW350 Partial Project alatt kattintsunk az egér jobb
gombjaval a Control Flows-ra, és valasszuk a New = Control Flow opciot.

81. A kivalasztott data warehouse project legyen a DW350 Partial Project. A vezérlési
folyam neve legyen Marts Control Flow. Finish.

Lathatd, hogy a vasznon megjelent az ujonnan létrehozott vezérlési folyam grafja, ami
momentan egyetlen egy Start operatorbdl all.

82. Tegylink a Start operator mogé egy Data Flow operatort. A Properties részben allitsuk
at a Label-jét Marts Time-ra (és érvényesitsilkk a valtoztatast pl. ugy, hogy
atkattintunk a Description mezobe), a Data Flow részben ugyanitt pedig bongéssziik
ki a marts-time adatfolyamot.
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84.

Ismételjik meg az eldbbi miveletet még haromszor! Hozzunk Ilétre egy
Marts_Product, Marts_Store, és Marts_Fact Data Flow operatort a vezérlési
folyamunkba (egymads utdn, sorban), melyek rendre a marts-product, marts-store, és
marts-fact adatfolyamokra épitenek.

A Start start-kimenetét (kis kék jobbra nyil) kossiik a Marts Time operator input-
jéara (kis kék jobbra nyil), utdna pedig sorra az On_Success kimeneteket (kis zold
pipa) a kozvetlen rakovetkezd operator input-jara. Igy tehat 5 operatorunk lesz sorba
kotve: Start > Marts_Time > Marts_Product - Marts_Store > Marts_Fact

Ezzel tehat sorba kotottik (daisy chain) a 4 1étezd adatfolyamunkat (sikeres végrehajtast
feltételezve).
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Mozgassunk most egy Command operatort a legjobboldalibb, Mart Fact nevii
operatorunktdl jobbra, és kossiik 9ssze 6ket On_Success-szel.

A Command operator Properties részében a Command type maradjon DB2 SQL
Script, and SQL script location mezdbe viszont bongéssziik ki a kovetkezot:
C:\IBM\DWE\samples\data\countMartTables.sql. A DB2 connection-be pedig
valasszuk ki a DWESAMP adatbazist.

Fejezziik be vezérlési folyamunkat azaltal, hogy egy End operatort tesziink a végére, a
Command-t6] jobbra. A Command operatort unconditional kimenetét (kis kék
jobbra nyil) kossiik az End end-bemenetére (kis kék jobbra nyil).

Ezzel akar mar készen is lehetnénk, de felmeriilhet a kérdés, hogy mi térténjen akkor,
ha barmelyik adatfolyam végrehajtasa kudarcot vall? Ebben az esetben az adott
adatfolyamoknak megfelelé Data Flow operatorok On_Failure port-javal (kis piros X)
kellene kezdeniink valamit, példaul kiildeni egy értesité email-t az illetékesnek. Ezt
Email operatorok vezérlési folyamba valo illesztésével tudjuk megoldani.
Mindazonaltal, ha az illetékes minden esetben ugyanaz, akkor sziikségtelen minden
egyes operatorhoz kiilon-kiilon Email operatort tenni. Elég tehat, ha most a Start
operatortol jobbra, lentebb elhelyeziink egy Email operétort, €s a Start On_Failure
port-jat (kis piros X) az Email operator input-jara kotjiik.

Rakjunk még az Email operator mogé egy End-et is, ¢és kossiik Oket Ossze
unconditional alapon.

Az Email operator Properties részében adjunk meg 1-1 email cimet a Sender-hez, és a
Receiver-hez is (itt tigyeljiink arra, hogy ne valtozoként, hanem Fixed Value-ként
adjuk meg Oket), illetve a Subject-hez irjuk be azt, hogy Failure.

Ezek utdn kattintsunk a vaszonra, mentsiik munkénkat (Ctrl+S), és validaljuk a
vezérlési folyamot (Control Flows = Validate). Ha minden rendben lezajlott, X-
eljiik ki a vezérlési folyamot, és a két adatfolyamot is a vasznon.

A kovetkezokben megismerkediink a vezérlési folyamokba iktathato iteraciékkal. Ezek
lényegében a FOR-ciklusokhoz hasonlitanak. Konkrétan adatfolyamok valtozo
paraméterekkel torténd iterdlt végrehajtasaval fogunk foglalkozni. Ehhez az elézdleg
l1étrehozott ,,Load DWH Fact” nevii adatfolyamunk modositott valtozatat fogjuk felhasznalni.
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A Data Project Explorer-ben zsugoritsuk most 6ssze a DW350 Partial Project-et, és
bontsuk ki a DW350 Warehouse Project-et, azon beliil a Data Flows-t, ott pedig
nyissuk meg a Load DWH Fact adatfolyamot.

Kattintsunk a File > Save As meniipontra, ¢s Load DWH Fact Update.dataflowxmi
néven, Ujra mentsiik el az adatfolyamot.

Modositsuk most az adatfolyam elején talalhato masodik File Import (File
Import_02) operatort! A Properties részében a File Name-et allitsuk at Use Variable-
re (a kis gyémantos Al-es ikonra kattintva), majd kattintsunk a téle jobbra 1€vé .....”
gombra, hozzunk 1étre egy 1j valtozot itm_txn_update_file néven, aminek a tipusa
File, értéke C:\DW35\sqw\DWH_ITM_TXN _1.txt, és a ,Final phase for value
changes” pedig szokés szerint EXECUTION_INSTANCE legyen, majd OK.

Valasszuk ki az Ujonnan létrejott valtozot a Variables listdban, €s kattintsunk a
Replace gombra (ahhoz, hogy a masodik File Import 02 operatorban megfeleloképp
frissiiljon a File Name mez0).

Folytassuk most tovabb az adatfolyam modositasat! Eloszor is allitsuk at a Union
operator Properties részében, a Set Details fiilben a set operation-t
INTERSECTION-re.

Ezek utan véalasszuk ki a Data Station operatort, és a Properties-ének a legaljan
kattintsuk be a Pass through jelolddobozt. Ennek hatdsara a Data Station operator
végrehajtasa soran a Staging Table-be nem fognak bejegyzések keriilni (hiszen az
adott, DWH.ITM_TXN tablaban az el6zéek folytan mar amugy is vannak adatok,
folosleges volna dket most tor6lni). Mindebbdl tovabba az is lathatd, hogy a Data
Station operatorokat a tervezés/fejlesztés/tesztelés utan, élesben (a deployment soran)
akar ki is vehetjiik az adatfolyambol.

Most mentsiik a valtoztatasokat, és validaljuk (de végre ne hajtsuk!!) az adatfolyamot.

Most pedig, a mddositott adatfolyamra épitve, 1étrehozzuk azt a vezérlési folyamot, amely
immar iteracidt is tartalmaz. Az iteraciot ugy fogjuk megvalositani, hogy lesz egy
szovegtajlunk, amelynek tartalma szovegfajlok neve €s elérése. Az iteracio soran ezen a listan
végighaladva fogjuk az egyes elemeket (a fajlneveket, amik adatforrasokat azonositanak) az
imént modositott adatfolyamunk megfeleld (itm txn update file) valtozojaval egyesiteni, €s
igy az adatfolyamot ismételten végrehajtani.

El6szor is a DW350 Warehouse Project-hez hozzunk 1étre egy 1j vezérlési folyamot
ITM_TXN_Control néven.

Tegylink egy Iterator operator-példanyt a Start-tdl jobbra, és csatlakoztassuk a
Start start-kimenetét az Iterator inmput-jahoz, majd az Iterator Properties-ében az
Iteration action-t allitsuk 4t Repeat look for each delimited data item in a file-ra, a
File Name-hez bongéssziik ki a C:\DW3S\sqw\DWH_ITM_TXN_update_files.txt
fajlt, az Iteration delimiter-t allitsuk vesszoére (azaz legyen .,,”), és az Iteration
variable mezo6nél 1€v0 .....” gombra kattintva valasszuk ki az itm_txn_update_file-t,
majd Select.



101. Az Iterator operator beallitasat kovetden tegylink egy Data Flow operatort a
vaszonra, az Iterator-tol jobbra, fentebb. A Data Flow operator Properties részében
adatfolyam gyanant a Load DWH Fact Update-et adjuk meg.

102. Csatlakoztassuk most az Iterator kimend loop port-jat a Data Flow input-
jéhoz, ¢és a Data Flow unconditional kimenetét pedig az EndIterator input-jahoz.

103. Tegylink tovabba egy End operatort az EndlIterator-tol jobbra, és
csatlakoztassuk az Endlterator unconditional kimenetét az End operatort input port-
jara.

104. Ezek utan kattintsunk a vaszonra, mentsiik eddigi munkankat (Ctrl+S), és

validaljuk a vezérlési folyamot (de még semmiképp se hajtsuk végre!!).

105. El6szor is, ha ,,mindez volt, ahogy irva”, nyissuk meg az adatforrasok list4jat
tartalmazé C:\DW3S\sqw\DWH_ITM_TXN_update_files.txt fajlt Notepad-del. A
fajl tartalma a kovetkezo kell, hogy legyen (irjuk at, ha nem ilyen):

C.\ DVWB5\ sqwA DWH | TM TXN update_1.txt, C.\ DWB5\ sqwh DWH_| TM TXN updat e_2. t xt

106. Mentsiik le, és zarjuk be a szovegfajlt. Hajtsuk végre (execute) a vezérlési
folyamot. Bizonyosodjunk meg arr6l, hogy a végrehajtas gond nélkiil végbement
(succeded), és végezetiil zarjuk le a vasznon az adatfolyamot, és a vezérlési folyamot.

A kovetkezokben megismerkediink majd azokkal a megoldasokkal, amik lehetévé teszik,
hogy az SQL Warehousing Tools-szal eddig elkészitett vezérlési folyamainkat web-
alkalmazasokként is kozzétegylik. Ehhez a WAS (Websphere Application Server) alkalmazas
szervert fogjuk igénybe venni. Erre a szerverre fogjuk deploy-olni a web-alkalmazasunkat (a
megfeleldképp becsomagolt vezérlési folyamo(ka)t), €s ezen is fogjuk futtatni oket. A futasi
(runtime) kérnyezet menedzselésére a DWE Administration Console web-alkalmazas valo.

107. A Data Project Explorer-ben jobb egérgombbal Kkattintsunk a DW350
Warehouse Project-re, és ott valasszuk a New - Data Warehouse Application
opcidt, majd Next. A Profile Name legyen DW350 Load_Profile, majd megint
Next. Az Availabe Control Flows részrol tegyiik 4t az ebben az adattarhaz projektben
talalhato egyetlen vezérlési folyamunkat (ITM_TXN_Control) a Selected Control
Flows részre, majd Next. A Resource Profiles részen ne valtoztassunk, inkabb
kattintsunk a Next-re, majd a valtozokon se valtoztassunk (hiszen mindharom
hivatkozva van a vezérlési folyamban), igy megint Next, majd mivel a futasi
kornyezetben nincs most sziikségiink DDL-re, ezért megint Next, aztan kattintsunk a
Next-re a Saving Application Profile, é¢s Code Generation oldalakon is, &m a Package
Generation oldalon allitsuk be a Zip file directory-t a c:\temp-re, és Finish, és OK.

108. Ezek utan lezarhatjuk a Design Studio-t (File = Exit), ¢s inditsuk el a WAS
alkalmazas szervert (Start menii = All Programs -> IBM WebSphere —>
Application Server 6 = Profiles 2> default > Start the Server). Varjuk meg, amig
a felugrd parancssori ablak magétol bezarodik (ez 1-2 percig is eltarthat).



109. Most pedig nyissuk meg a WAS szerveren alapértelmezésben futé dweadm
web-alkalmazast. Ehhez kattintsunk duplan az asztalon 1év6 DWE Administration
Console ikonra, majd a feljové browser-ablakban 1épjiink is be (Log in) db2adni n
felhasznaloval, €s i bnbl ue jelszoval a web-alkalmazasba.

A kovetkezokben adatforrasokhoz fogunk csatlakozni, masképp ugyanis a WAS szerver nem
lesz képes hozzajuk férni.

110. A bal oldali meniiben bontsuk ki a DWE SQL Warehousing - Resources
részt, és kattintsunk a Create Data Sources-ra (majd varjunk egy picit, amig
betoltddik a megfeleld oldal).

111. JNDI Name-nek a jdbc/dwesamp-ot adjuk, az Attached to WAS opcio
legyen No, irjuk be a megfeleld felhasznalo nevet, ¢s jelszét, majd a Display Name
legyen DWESAMP, a Database Type maradjon DB2, a Database Name pedig
legyen a mar megszokott DWESAMP.

112. A felkonfiguralt adatkapcsolat leteszteléséhez kattintsunk a Test connection
gombra, és tiirelmesen varjuk meg az eredményt. Ezek utan, ha minden rendben volt,
kattintsunk a Finish-re.

A laborgyakorlat (avagy az egyszerliség) kedvéért a forrds és cél adatbazis tablak most
egyazon adatbazisban helyezkednek el. A gyakorlatban azonban ez nyilvan nem mindig van
igy, és ezért legtobbszor kiilon adatkapcsolatot kell 1étrehozni mind a forrds, mind a cél
adatbazisok szamara.

113. A bal oldali meniiben bontsuk ki a Data Warehouse Applications részt, és ott
kattintsunk a Deploy Data Warehouse Applications-re.

114. Bizonyosodjunk meg arrél, hogy a Location of .zip File on Web Client opci6
van kivalasztva, majd bongéssziik ki az eldzbéekben Ilétrehozott ZIP fajlt
(c:\Temp\DW350 Load Profile.zip), majd kattintsunk a Next gombra, aztan az
attekint6 oldalon is kattintsunk a Next-re.

115. Valtoztassuk a web-alkalmazas nevét (Application Name) DW350WHA -ra,
az Application Home Directory legyen ¢:/DW3S0WHA/Home, a Log Directory
legyen ¢:/DW3S0WHA/log, a Working Directory legyen ¢:/DW350WHA/Work,
majd kattintsunk a Next-re.

116. Mivel egyetlen adatforrdsunk van csak, ezért nincs sok valasztasunk,
kattintsunk a Next-re. Mivel rendszer er6forrasokat sem definialtunk (FTP szerverek,
stb), ezért yjfent kattintsunk a Next-re.

117. A valtozdink esetében minden alapértelmezett érték megfeleld, igy hat
kattintsunk a Finish-re. Vegyiik észre, hogy a deploy-olt web-alkalmazas
automatikusan tizembe is 1ép (Enabled).

118. Kattintsuk be a DW3S0WHA melletti Select-jelolddobozt, majd kattintsunk az
Update gombra. Valasszuk ki a Variables fiilet, és tekintsiik at (itt még akar most is
valtoztathatnank az értékeken).



119. Ezek utan bontsuk ki a bal oldali meniiben a Processes fiilet, és kattintsunk a
Run Processes linkre.

120. Itt valasszuk ki egyetlen folyamatunkat (Select checkbox), és kattintsunk a
Start-ra. A kovetkezd képernydn a web-alkalmazés adott, futtatandd példanyanak
nevét adhatndnk meg, de mi Kkattintsunk inkabb a Next-re, ¢s hagyjuk, hogy
automatikusan generalodjon egy alapértelmezett név.

121. A valtozok értékén tovabbra sincs értelme valtoztatni, habar, mivel
EXECUTION_INSTANCE-ra allitottuk megvaltoztatasuk végsé fazisat, ezért most
ujfent lehetdségiink volna ra. Kattintsunk a Finish-re.

122. A web-alkalmazés e példanyanak allapota kezdetben Started, majd Running,
majd pedig Finished lesz. Ha a Refresh gombot kell6 gyakorisaggal nyomkodjuk,
ugy mindegyik allapotot lathatjuk. Mikor az allapot Finished-re valtott, kattintsuk be a
Select jelolédobozt, és kattintsunk a Monitor gombra.

123. A bal oldali meniiben kattintsunk a Monitor Process Instances-ra, majd
kattintsunk alkalmazés-példanyunk nevére (Instance name), és nézziikk meg a HTML
log f34jlt a Process Log sorban. Ha barmilyen hiba adddott a futtatds soran, azt itt
lathatjuk.

124. Folytassuk az adminisztracids konzol megismerését a History and Statistics
résszel (ezt bontsuk most ki a bal oldali meniiben).

125. Kattintsunk a View Deployment History-ra. Itt nincs sok latnivald.

126. Kattintsunk a View Statistics for Process Instances-ra (bal oldalt), és
kattintsunk a folyamat-példany nevére. Nézziik végig a kiilonbozé fiileket, amikben
kiilonboz6 statisztikai informéaciokat lathatunk folyamatunk e példanyardl.

127. A bal oldali meniiben még megnézhetjiik a Logs and Traces részt is, ahonnan
gyakorlatilag ugyancsak hozzaférhetiink az el6bbi informacidkhoz, tovabba a
szerverre vonatkozo statisztikakat is megtekinthetjiik.

128. Folytassuk most alkalmazasunk uninstalldldsaval! A bal oldali meniiben
kattintsunk a DWE SQL Warehousing - Data Warehouse Applications >
Manage Data Warehouse Applications linkre.

129. Itt valasszuk ki web-alkalmazasunkat, kattintsunk az Uninstall gombra,
bizonyosodjunk meg arré6l, hogy a Yes van kivalasztva, és Finish.

Egyeldre, ezen a laborgyakorlaton még nem foglalkozunk a Cube Views-szal, vagy az
Intelligent Miner-rel. Mindazonaltal mindkettd szamara sziikséges az, hogy engedélyezziik
(enable) a megfeleld adatbazist, amire alapoznak. Ez lényegében azt jelenti, hogy az emlitett
alkalmazasoknak az adott adatbazisban adott tablakra, tarolt eljarasokra, felhasznalo altal
definialt funkciokra, stb, van/lehet sziiksége. Az engedélyezés sordn tehat ezek az objektumok
jonnek létre. Természetesen nem csak a DWE Administration Console-on engedélyezhetiink
adatbazisokat, hanem a Design Studio-bdl is, amde az utdbbival inkabb fejlesztéi és/vagy
teszt adatbazisokat szokas engedélyezni, mig az elébbivel éles verziokat is.



130. Hozzunk eldszor is létre egy adatbéazis profilt, amit engedélyezhetiink!
Kattintsunk a DWE Common - Database Profile linkre, majd a Create gombra.

131. A profil neve legyen CVProf. A Profile Create Option legyen Create
Profile with a New Data Source. Kattintsunk a Next-re.

132. Az 1j képernyén a JDBC Provider legyen DB2 Universal JDBC Driver, a
Data Source Name legyen CVSAMPLE, a JNDI Name legyen jdbce/dwe/cvsample,
a Database Name legyen CVSAMPLE, és kattintsunk a Next-re, majd irjuk be
jelszavunkat, és Create.

133. Valasszuk ki a 1étrejott profilt, és kattintsunk a Test gombra.

134. Ha minden rendben volt, akkor kattintsunk most a bal oldali meniiben a DWE
Common > Database Enablement linkre, majd jeloljik ki mind a Mining, mind
pedig az OLAP jelolddobozokat, kattintsunk a Check Enable Status gombra.
Lathatjuk, hogy az adatbdzis nincs még engedélyezve egyik szempontbdl sem, igy
kattintsunk a Back gombra, ¢s kattintsuk ki a Mining checkbox-ot, és kattintsunk az
Enable Database gombra, majd az Enable-re.

135. Most pedig, hogy ezzel készen vagyunk (és elokészitettiik a kovetkezd mérésre
a CVSAMPLE adatbazist) — és a gyakorlatvezetonek is bemutattuk eddigi munkankat
—, jelentkezziink ki a jobb fels¢ sarokban 1évd kis Logout linkre kattintva, aztan
kattintsunk a Logout gombra, és zarjuk le a bongészot.

136. Most pedig allitsuk le a WAS szervert (Start menii 2> All Programs - IBM
WebSphere > Application Server 6 > Profiles = default = Stop the Server).



